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SINTAXE DOS COMANDOS

Neste tutorial são utilizados sequências de procedimentos padronizados para 
descrever a operação nas diversas janelas do sistema. Os procedimentos para 
realização dos exercícios práticos seguem a seguinte sintaxe:

⇒Descreve uma sequência de operações:
* inicia-se uma sequência de procedimentos

# Comando a ser executado a partir do menu Iniciar do Windows 
ex:  # Iniciar - Programas - Spring-<versão>

- [Função]   - opção da barra de menu (principal ou outros) ou botão na barra de 
ferramentas

ex:    - [Arquivo][Banco de Dados...] ou botão �        =  �

- {Campo ⌨   <nome a preencher>}  - nome de um campo a preencher (em negrito)

ex:    - {Nome: ⌨   Modelo_Dados}         =   �

- {Área – Campo ⌨   <nome a preencher>} - nome de um campo e uma área específica 
a preencher

ex:     - {Classes Temáticas - Nome: ⌨   Principais }     =   

- {Campo - Nome1: ⌨   Nome1 a preencher, Nome2: ⌨   Nome2 a preencher} - 
nomes dos campos a preencher

ex:     - {Retângulo Envolvente - X1: ⌨    183000, X2: ⌨    195000, Y1: ⌨   
8745000, 

Y2: ⌨   8780000}

�
- (Botão) - botão a clicar

ex:     - (Criar)                =   �

- (<local/ “item”>)  !  [menu a escolher]  - Menu pop-up – escolher opção 
ex: - (SPRING " Tela 2)  !  [Flutuar]                                                       



- (Árvore  – selecionar  item ! sub-item de uma árvore) 
ex:     - (Categoria / Plano de Informação – Imagem_TM ! TM_5)      

- (Campo ▼ Botão) - botão de campo específico a clicar e selecionar
ex:     - (Gerenciador ▼ Access) =         

- (Botão ◉ Opção) - botão de opção única a selecionar

ex:     - (Coordenadas:  ◉  Planas)   =    �

- (Campo ☑ Opção1, Opção2, etc) – ative botão de opções múltiplas a selecionar

- (Campo ⬜  Opção1, Opção2, etc) – desative botão de opções múltiplas 
ex:     - (Representações  ☑  Polígonos, Textos)       

- (Lista " Elemento) - Elemento de lista a selecionar
ex:     - (Categorias " Declividade)

- (Lista " Elemento1, Elemento2, Elemento3, ...) - Elementos de lista não exclusiva a 
selecionar

ex:     - (Bandas "  [Imagem_TM] – TM_3, [Imagem_TM] – TM_5)

Janela - Janela de comandos ativa a operar – linha tabulada a esquerda.
ex:     Banco de Dados     

Janela "  aba – Janela com abas para selecionar – clique na aba indicada
ex:     Importação  "  Saída                        =   

asterisco (*)  – Comentários de um procedimento a ser executado.       (em itálico – 
tamanho 10)
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Parte 1 - Download de Imagens do Copernicus Open Access Hub

Exercício– Download de Imagens
⇒Acessando o sítio WEB:

- # Chrome (ou outro Browser)
* Acessar o sítio: scihub.copernicus.eu
* Logar no sistema - Criar uma conta nova se ainda não tiver.

⇒Definindo Área de Interesse:
* Selecione o ícone de vôo (Pan).
* Mover o mapa até a região de interesse. Alterar o zoom conforme 

necessário
* Selecione o ícone de Retângulo (Box).
* Desenhe um retângulo contendo o contorno da área.

⇒Selecionando Data, Satélite e Sensor:
* Selecionar data inicial (2017/06/01) e final (2017/06/31).
* Selecionar Missão: Sentinel 1 - Os dois (S1A e S1B) selecionados.
* Selecionar Tipo de produto - GRD (Ground Range Detected - Projetado 

em Ground Range, valores em magnitude, não existe fase).
* Selecionar Modo - IW (Interferometric Wide Swath - Adquirido em 3 

faixas, resolução espacial de 20x22 metros em Range x Azimute).
* Buscar.

⇒Selecionando Imagens:
* Observe as imagens disponíveis. 
* Clique em uma delas para visualizar no mapa.
* Selecione a imagem do dia 2017/06/14, com recorte acima de Salto, 

Uruguai.
⇒Download de Imagens:

* Clique na ícone de Download da imagem desejada.

⇒Download de Imagens de Antes da Inundação:
* Repetir para o mês de setembro de 2016, selecionando e fazendo 

Download da imagem do dia 2016/09/05.

⇒Download de Imagens Multiespectrais de Antes da Inundação:
* Repetir para o mês de abril de 2017, selecionando Sentinel-2, 

selecionando e fazendo Download da imagem do dia 2017/04/04.



Parte 2 - Recorte no SNAP

⇒ Iniciando o SNAP e importando as imagens:
SNAP 
* Abrir Explorador de Arquivos, localizar os arquivos *.dim, marcar, arrastar 

e largar sobre a janela do SNAP.
Explorador de Arquivos
* Selecionar diretório CursoCENAD_Radar\Sentinel.
* Selecionar os arquivos *.dim (múltiplos):

• S2A_MSIL1C_20170404T135111_N0204_R024_T21JVG*.dim
• S1A_IW_GRDH_1SDV_20160905T091347_20160905T0*.dim
• S1B_IW_GRDH_1SDV_20170614T091259_20170614T0*.dim

* Arrastar e largar sobre a janela do SNAP.
* Para visualizar, localize a banda e clique duplo para abrir a visualização. 

Utilize Banda 8 para Multiespectral e Amplitude VV ou HH para as Radar.

⇒Recortando a Imagem Multiespectral
* As imagens do Sentinel-2 tem bandas com diferentes resoluções. O 

recorte no SNAP pode ser feito somente sobre bandas de mesma 
resolução. Uma reamostragem para a resolução espacial melhor é feita 
sobre toda a imagem, com resolução espacial de 10 metros. Sobre esta 
imagem reamostrada, o recorte é realizado:

SNAP 
* Selecionar o arquivo S2A_MSIL1C_20170404T*
- [Raster][Subset]
Specify Product Subset 
- (Geo Coordinates) 
Specify Product Subset "  Geo Coordinates
- {North latitude bound: ⌨  -30.05}
- {West longitude bound: ⌨  -57.80}
- {South latitude bound: ⌨  -30.35}
- {East longitude bound: ⌨  -57.50}
Specify Product Subset 
- (Band Subset) 
Specify Product Subset "  Band Subset
- (Select none) - * Desmarca todos.
- (Bands ☑ B2, B3, B4, B8)
- (OK) 

⇒Recortando a Imagem Radar
SNAP 
* Selecionar o arquivo S1B_IW_GRDH_1SDV_20170614T*
- [Raster][Subset]
Specify Product Subset 
- (Geo Coordinates) 
Specify Product Subset "  Geo Coordinates
- {North latitude bound: ⌨  -30.05}



- {West longitude bound: ⌨  -57.80}
- {South latitude bound: ⌨  -30.35}
- {East longitude bound: ⌨  -57.50}
Specify Product Subset 
- (Band Subset) 
Specify Product Subset "  Band Subset
- (Select none) - * Desmarca todos.
- (Bands ☑ Amplitude_VV)
- (OK)  
* Repetir para a imagem S1A_IW_GRDH_1SDV_20160905T*.



Parte 3 - Processamento das Imagens Radar

⇒Gerando Imagem Multilook - Reduz o ruído através de uma composição  
de visadas múltiplas (simuladas neste caso, onde existe somente uma 
visada)

SNAP 
* Selecionar o arquivo S1B_IW_GRDH_1SDV_20170614T*
- [Radar][Multilooking]
Multilooking "  Processing Parameters
- (Number of Range Looks ☑ 3)
- (Number of Azimuth Looks ☑ 3)
- (Bands ☑ Amplitude_VV)
- (Bands ☑ Amplitude_VH)
- (Run)  
* Imagem de saída é gerada com sufixo *_ML
* Repetir para a imagem S1A_IW_GRDH_1SDV_20160905T*.

⇒Calibrando - Imagem calibrada apresenta o valor de retorno do radar 
(backscattering) sem influências “externas" e permite comparações 
quantitativas

SNAP 
* Selecionar o arquivo S1B_IW_GRDH_1SDV_20170614T*_ML
- [Radar][Radiometric][Calibrate]
Calibration "  Processing Parameters
- (Bands ☑ Amplitude_VV)
- (Bands ☑ Amplitude_VH)
- (Sigma0)
- (Run)  
* Imagem de saída é gerada com sufixo *_ML_Cal
* Repetir para a imagem S1A_IW_GRDH_1SDV_20160905T*_ML.

⇒Filtragem Speckle - Filtragem para eliminar ruído Speckle
SNAP 
* Selecionar o arquivo S1B_IW_GRDH_1SDV_20170614T*_ML_Cal
- [Radar][Speckle filtering][Single Product Speckle Filter]
Calibration "  Processing Parameters
- (Source Bands ☑ Amplitude_VV)
- (Source Bands ☑ Amplitude_VH)
- (Filter ☑ Gamma Map)
- (Filter Size X ☑ 5)
- (Filter Size Y ☑ 5)
- (Run)  
* Imagem de saída é gerada com sufixo *_ML_Cal_Spl
* Repetir para a imagem S1A_IW_GRDH_1SDV_20160905T*_ML.



⇒Correção geométrica - Posiciona na localização correta e executa  a 
correção de terreno. A imagem de saída estará georreferenciada.

SNAP 
* Selecionar o arquivo S1B_IW_GRDH_1SDV_20170614T*_ML_Cal_Spl
- [Radar][Geometric][Terrain Correction][Range-Doppler Terrain Correction]
Range-Doppler Terrain Correction "  Processing Parameters
- (Source Bands ☑ Amplitude_VV)
- (Source Bands ☑ Amplitude_VH)
- (Digital Elevation Model ☑ SRTM 1sec HGT (Auto Download))
- (Run)  
* Imagem de saída é gerada com sufixo *_ML_Cal_Spl_TC
* Repetir para a imagem S1A_IW_GRDH_1SDV_20160905T*_ML_Cal.

⇒Conversão para dB - Converte imagens para valores em decibel.
SNAP 
SNAP "  Product explorer
- Right-Click - Botão direito (*_ML_Cal_Spl_TC)
- Linear to/from dB]
* As imagens db são virtuais. Para instanciar a imagem, right-click sobre a 

banda e selecionar a opção [Convert Band] 

⇒Exportação para GeoTIFF
SNAP 
- [File][Export][GeoTIFF/BigTIFF]
- Selecionar nome e diretório
- Salvar 



Parte 4 - Estimativa de Área Inundada

A estimativa será realizada utilizando o TerraView. Procure e inicie o 
TerraView.
Obs: Nesta parte, as imagens utilizadas são as referentes ao chamado 
Charter 685 (Cheia no RS em Janeiro 2019).

⇒Abrindo as Imagens GeoTIFF exportadas
TerraView 
* Procurar o arquivo Uruguaiana_S1A_20190117_Cal_Spk_TC.tif
* Selecionar e Arrastar, soltando sobre a janela com o TerraView.
* Repetir para Uruguaiana_S1B_20181225_Cal_Spk_TC.tif

Visualização de Imagens 

⇒Visualizando as Imagens GeoTIFF
TerraView " Layer Explorer
- (Uruguaiana_S1A_20190117_Cal_Spk_TC.tif)
TerraView 

- [Map][Zoom Extent] ou ícone �  da Barra de Ferramentas
* A imagem visualizada está praticamente toda escura. Precisamos definir 

parâmetros de no-data e contraste.
* O valor dummy (no data - utilizado para indicar onde informações não 

estão disponíveis) não está definido. Como sabemos que é zero, 
precisamos informar.

TerraView 
- [View][Style Explorer] ou ícone �  da Barra de Ferramentas
* O valor dummy (no data - utilizado para indicar onde informações não 

estão disponíveis) não está definido. Como sabemos que é zero, 
precisamos informar.

Layer Style " Style
* Observe que Channel Selection está Mono selecionado e 0 (indicando 

a visualização default em tons de cinza da primeira banda da imagem 
GeoTIFF - a primeira banda corresponde a polarização VH e a segunda 
à VV, de acordo com a ordem apresentada no SNAP).

- {Value to be Used ☑ 0}

- Clique sobre o botão �

* Para atualizar o desenho, clicar sobre o botão � .

⇒Alterando o contraste
* As imagens apresentam um contraste automático linear entre o valor 

mínimo e máximo encontrados na imagem. Para definir um novo 
contraste, utilizamos o histograma da área visível para obter os novos 
mínimo e máximo. Utilizando Zoom (botão � ), desenhar uma área 
menor sobre a imagem.



Layer Style " Contrast
- (Type ☑ Linear)
- (Band ☑ 0)

- Clique sobre o botão �

* Para utilizar os limites sugeridos, clicar sobre o botão � .
* Para altera os limites sugeridos, clicar com botão esquerdo dentro do 

gráfico com histograma (limite inferior) ou com o botão direito (limite 
superior). Pode se ainda digitar os novos valores nos campos Min e 
Max.

* Repetir para a banda 1 polarização VV, alterando em Channel Selection 
- Mono de 0 para 1.

* Repetir para Uruguaiana_S1B_20181225_Cal_Spk_TC.tif.

Gerando as Imagens Pré evento e Evento em Intensidade
* Visualizando as imagens com e sem cheia em cores diferentes pode-se 

localizar as áreas alagadas em uma cor preferencial (azul, neste 
exemplo). As imagens GeoTIFF estão com valores de Amplitude, que 
devem ser transformadas em valores de Intensidade para facilitar o 
processamento e visualização por comprimir a faixa de valores 
possíveis. A função Intensidade é definida pela Raiz Quadrada da 
Amplitude.

⇒Calculando as imagens Intensidade da imagem do evento
TerraView " Layer Explorer
- (Uruguaiana_S1A_20190117_Cal_Spk_TC.tif)
TerraView 
- [Processing][Raster Processing][Arithmetic Operations]
Arithmetic Operations
- (Layer: …)
Layer Search
- (List of Layers ☑ Uruguaiana_S1A_20190117_Cal_Spk_TC.tif)
- (OK)
Arithmetic Operations
- (Sqrt)
- (+) - Observe que Band: 0
- ( ) )
* Observe que o campo texto contém:  
sqrt( Uruguaiana_S1A_20190117_Cal_Spk_TC.tif:0 )
- Desmarcar (Normalize) - Não transformar em valores entre 0 e 255.
- (Repository: …)
Seleção de Diretório e Arquivo
- Selecionar um diretório (Dados, por exemplo)
- {Save as: Uruguaiana_S1A_20190117_VH_I.tif} - Banda 0 é VH.
- (Save)
* Observe que o formato é GeoTIFF.
Arithmetic Operations
- (OK)



* Utilizar a mesma interface preenchida para gerar a imagem 
Uruguaiana_S1A_20190117_VV_I.tif. Para isto, altere no campo texto para 
sqrt( Uruguaiana_S1A_20190117_Cal_Spk_TC.tif:1 ) Band: 0 é VV e a 
imagem de saída para Uruguaiana_S1A_20190117_VV_I.tif.

* Para calcular as imagens Intensidade VH e VV do pré evento, repetir 
utilizando Uruguaiana_S1B_20181225_Cal_Spk_TC.tif como Layer e 
gerando as imagens Intensidade Uruguaiana_S1B_20181225_VH_I.tif e 
Uruguaiana_S1B_20181225_VV_I.tif.

⇒Visualizando as Imagens Pré evento e Evento em Intensidade
* Visualizar as imagens Evento e Pré evento, como mostrado 

anteriormente. Observe que o valor dummy (no-data) não precisa ser 
definido, uma vez que este foi transportado durante a operação 
aritmética.

* Os níveis mínimo e máximo das imagens Intensidade devem ser 
definidas iguais para as imagens Evento e Pré evento. Para VV, o 
mínimo sugerido é 0.1 e o máximo 0.5, enquanto que para VH devem ser  
0 e 0.25.

*
⇒Visualizando Áreas Inundadas em Azul

* A composição colorida de imagens Evento e Pré evento é utilizada para 
realçar áreas inundadas em azul. Neste exemplo, utilizaremos a 
polarização VV.

TerraView " Layer Explorer
- (Uruguaiana_S1B_20181225_VV_I.tif)
- [View][Style Explorer] ou ícone �  da Barra de Ferramentas
Layer Style " Style
- (Channel Selection: Blue Channel) - Banda seleciona é 0 (existe somente 

uma banda nesta imagem).

* Clicar sobre o botão �  para desenhar.
TerraView " Layer Explorer
- (Uruguaiana_S1A_20190117_VV_I.tif)
TerraView
- [View][Style Explorer] ou ícone �  da Barra de Ferramentas
Layer Style " Style
- (Channel Selection: Green Channel) - Banda seleciona é 0 (existe 

somente uma banda nesta imagem).

* Clicar sobre o botão �  para desenhar.
* Observe que a imagem aparece verde ou azul. Precisamos de 

transparência para fazer a composição de cores Verde-Azul. Verifique qual imagem está 
mais próximo do topo. Esta imagem deve ser a transparente.

* Clique com botão direito do mouse sobre a imagem que deve ser 
transparente.

- [Composition Mode][Plus]
* Clicar sobre o botão �  para desenhar.



Fatiamento para áreas inundadas 
⇒Definindo Limiares para Áreas Inundadas

* As áreas com água apresentam valores de reflexividade mais baixas que 
as áreas secas devido às propriedades dielétricas da água e a pouca rugosidade. Em 
píxels com valores abaixo do limiar, pode-se assumir que existe água. Para definir o 
valor, utilize o histograma disponível para executar o contraste. Verifique que em 
visualização de áreas com proporções parecidas de água e não água, o histograma é bi-
modal, com um clara separação entre as “gaussianas”. O valor aproximado no exemplo 
abaixo é de 0.12.

�

⇒Fatiando Áreas Inundadas

TerraView
- [Processing][Raster Processing][Raster Slicing] 
Raster Slicing
Layer Search
- (List of Layers ☑ Uruguaiana_S1B_20181225_VV_I.tif)
- (Next)
Raster Slicing
- {Max Value: 0.12} - Utilize outros valores de limiar para testar
- (Precision: 5)
- (Apply)
* Clique duplo sobre a cor (Color) - E selecione uma cor azul
- (Next)
Raster Slicing
Raster Information
- (Raster Info) - Selecione diretório e defina o nome do arquivo como sendo 

Uruguaiana_S1B_20181225_VV_Agua.tif
- (Finish)
* Visualize a imagem Uruguaiana_S1B_20181225_VV_Agua.tif gerada.

* repita para as imagens geradas com polarização VH, criando as imagens 
de saída Uruguaiana_S1B_20181225_VH_Agua.tif e 
Uruguaiana_S1B_20190117_VH_Agua.tif.

⇒Vetorizando (Criando Polígonos de) Áreas Inundadas
TerraView
- [Processing][Raster Processing][Vectorization] 
- (Repository) - Selecione diretório e nome do arquivo como sendo 

Uruguaiana_S1B_20181225_VH_Agua_V



- (Finish)
* Visualize o arquivo Shape Uruguaiana_S1B_20181225_VH_Agua_V 

gerado.
* Repetir para Uruguaiana_S1B_20190117_VH_Agua.tif.

Cálculo de áreas inundadas 
* As áreas com água podem ser calculadas sobre a imagem ou sobre os 

polígonos. Uma vez que o procedimento possível no TerraView para o cálculo sobre a 
imagem não é simples como poderia ser, somente o cálculo sobre os polígonos será 
apresentada.

⇒Reprojetando os dados vetoriais para projeção plana
* A área é calculada nas unidades do sistema de projeção cartográfica. 

Uma medida mais apropriada é executada utilizando uma projeção plana, o que permite 
que as áreas sejam calculadas metros quadrados. Para a escala e região da cheia, a 
projeção mais adequada é a UTM zona 21S com Datum SIRGAS2000.

TerraView " Layer Explorer
- (Uruguaiana_S1B_20181225_VH_Agua_V)
TerraView
- [Tools][Data Exchanger}{Layer]
Layer Explorer
- (Output Data Source Type ☑ Vector files)
- (Input Layer ☑ Uruguaiana_S1B_20181225_VH_Agua_V)
- (Data Set Name) - Selecionar o diretório e definir o nome como sendo 

Uruguaiana_S1B_20181225_VH_Agua_V_UTM.
- {Output SRID: 31981} - Ou clicar no ícone ao lado e selecionar na lista 

UTM zona 21S - SIRGAS2000.
- (OK)
* Repetir para Uruguaiana_S1B_20190117_VH_Agua_V, gerando 

Uruguaiana_S1B_20190117_VH_Agua_V_UTM
* Visualizar os novos vetores. Remover a definição de projeção do mapa 

(ícone � ) e redesenhar com Zoom Extents (ícone �  da Barra de Ferramentas).

⇒Subtraindo água antes da água do Evento
* Para calcular somente para as áreas alagadas, sem considerar as que já 

continham água (leito normal de rios, lagoas e reservatórios) deve ante executar a 
subtração da imagem antes do Evento da imagem do Evento.

TerraView " Layer Explorer
- (Uruguaiana_S1B_20190117_VH_Agua_V_UTM)
TerraView
- [Processing][Vector Processing][Difference] 
Difference
- (Input Layer ☑ Uruguaiana_S1B_20190117_VH_Agua_V_UTM)
- (Difference Layer ☑ Uruguaiana_S1B_20181225_VH_Agua_V_UTM)
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- (Repository …) - Selecionar o diretório e definir o nome como sendo 
Uruguaiana_20190117_Agua_Alagada.

- (OK)
* Visualizar as áreas alagadas.

⇒Calculando Áreas na Imagem
TerraView " Layer Explorer
- (Uruguaiana_20190117_Agua_Alagada)
TerraView
- [Processing][Vector Processing][Geometric Operation] 
Geometric Operation
- (Input Layer ☑ Uruguaiana_20190117_Agua_Alagada)
- (Tabular Operation ☑ Area)
- (Repository …) - Selecionar o diretório e definir o nome como sendo 

Uruguaiana_20190117_Agua_Alagada_Area.
- (OK)
* Visualizar o novo vetor.
TerraView " Layer Explorer
- (Uruguaiana_20190117_Agua_Alagada_Area) - Clique com botão direito.
- [Show Table]
* Observe a tabela que é apresentada. A coluna area indica a área em 

metros quadrados de cada um dos polígonos. A soma total desta coluna é a área total 
alagada.

TerraView " Tabela- Uruguaiana_20190117_Agua_Alagada_Area
- (area) - Clique com botão direito.
- [Statistics]
* Na tabela com Estatísticas,  a soma de valores é o total de área alagada.

Exportação para KML 
* Os polígonos de áreas alagadas pode ser convertido para o formato KML 

para visualização no Google Earth.

⇒Exportando para KML
TerraView " Layer Explorer
- (Uruguaiana_20190117_Agua_Alagada_Area)
TerraView
- [Tools][Data Exchanger}{Layer]
Layer Explorer
- (Output Data Source Type ☑ Vector files)
- (Input Layer ☑ Uruguaiana_20190117_Agua_Alagada_Area)
- (Data Set Name) - Selecionar o diretório e definir o nome como sendo 

Uruguaiana_20190117_KML.
- {Output SRID: 4386} - Coordenadas devem ser geográficas.
- (OK)
* Visualizar o arquivo no Google Earth. 



Suplemento 

9.Stack terrain corrected images 
.9.1.  Radar / Coregistration / Stack Tools / Create Stack  

.9.2.  In the first tab (1-ProductSet-Reader) use the plus icons to insert the 
terrain corrected images to the list.  

.9.3.  In the second tab (2-CreateStack) select “Product Geolocation” as the 
“Initial Offset Method”.  

.9.4.  In the third tab (3-Write) select the output name and directory. Then 
select “Run”.  

10. Check the coregistration 
.10.1.  Double click to open one of the bands of the stack  

.10.2.  Select the Layer Manager: View / Tool Windows / Layer Manager  

.10.3.  Select the plus icon (Add Layer)  

.10.4.  Select “Image of Band / Tie-Point Grid”  

.10.5.  Select “Next” and select one of the other bands from the stack  

.10.6.  Repeat the steps above for the third band  

.10.7.  Back in the “Layer Manager” window, select and deselect the check 
boxes of the three bands (or use the  
transparency slider) to compare the flood image with the archive and the 
DEM  

11. View RGB composite 
.11.1.  With the Stacked image selected in the “Product Explorer” window, 
select: Window / Open RGB Image  
Window  

.11.2.  To display the flooded areas in red: 
-  Red: Non crisis image in dB  

-  Green: Crisis in dB  

-  Blue: Crisis in dB  

.11.3.  To display the flooded areas in blue: 
-  Red: Crisis image in dB  

-  Green: Non crisis in dB  



-  Blue: Non crisis in dB  

.11.4.  Stretch the histogram of the various channels in the “Colour 
Manipulation” tab by sliding the triangular  
sliders to either side of the histograms  

.11.5.  Can you interpret those results?  

12. Save the image in Google Earth kmz format and view in Google Earth 
.12.1.  File / Export / Other / View as Google Earth KMZ  

.12.2.  Double click on the saved KMZ file to open it in Google Earth  

.12.3.  Use the transparency slider in Google Earth to compare the flood 
map with the optical imagery  

Next we quantify the area flooded. This is an interactive process where we 
estimate the threshold that separates water from land. 
13. Define a threshold that will be applied to the pixel values in the crisis 
image 
.13.1.  Select and display one of the images that are not in dB  

.13.2.  Go to Colour Manipulation tab (bottom left). Select log10 and use the 
grey triangle to estimate a threshold.  

.13.3.  Go to Raster > Band Maths. As name, add the prefix “water_” and 
the date of the crisis image. Uncheck the  
Virtual box. Select “Edit expression” and write the following, adapting the 
band you have used and the threshold you want to test.  
if Sigma0_VV_slv1_08Nov2014< thresholdvalue then 1 else NaN  
Have a look at the output and see if it is as you expected it. 
Below are some thresholds we tested, as examples. Which one do you think 
works best? We chose B.  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Threshold 
Value 
A 
7.93E-2 
B 
5.3E-2 
C 
3.06E-2 
13.4. Adapt the colour in the Colour Manipulation tab > Table (to blue, for 
example) 
13.5. Export it as KMZ (Note this will export the layer you are displaying!): 
File > Export > Other > View as Google 
Earth 



14. Not all the pixels in the mask of step 13 are likely to belong to the 
flooded area. We use a mask to export only the area that interests us: 
.14.1.  View > Tool Windows > Mask Manager > New Geometry icon. This 
creates a New Vector Data Container, that  
we can name “ My Area of interest”.  

.14.2.  Check that it now appears un the Product Explorer window, in the 
Vector Data folder of your product.  

.14.3.  If needed, activate the Tools toolbar via View > Toolbars > Tools.  

.14.4.  Use the Select Polygon Tool to draw a polygon around the area that 
interests us. Once done, click on the  
arrow symbol to stop the Polygon Drawing Tool.  

.14.5.  The Water_8Nov_thresB band needs now to be converted into a 
mask, so that the Mask Manager can use it  
as input: Go to Mask Manager > f(x) button, and simply enter the expression 
below. It will create a mask containing every pixel in the 
Water_8Nov_thresB band whose value is 1 (condition satisfied by all pixels 
in the band!):  
Water_8Nov_thresB == 1  

.14.6.  In the mask manager, feel free to rename it, as 
“Water_8Nov_thresB_mask” for example, and to change the  
colour.  

.14.7.  Highlight both masks (click on one, then SHIFT and click on the 
other) and select the symbol to create a new  
mask containing the intersection of the selected masks. Rename the output 
mask as Intersect  

.14.8.  Take some time to view the different results. Try to display the 
intersection mask on top of a S1 image  

.14.9.  Export your display (with the S1 image) as KMZ for Google Earth  

14.10. You can export the intersect mask itself as KMZ for Google Earth, but 
first it will need to be converted 
from mask into a band: Raster > Band Math. Name the new band, uncheck 
Virtual, and in Edit Expression, check Show Masks: 
if Intersect then 1 else NaN  
Then, in the Colour Manipulation tab, change the colour to, for example, 
dark blue. 
Then display this Intersect_band and Export it as KMZ for Google Earth. 
Note: with an image editor (e.g. Irfan View), KMZ colours can be adapted as 
well) 


